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Abstract: This paper presents an overview on movie promotion 

application. 

 
Keywords: Movie Promotion Application 

1. Introduction 

The Objective of the project is to promote and be available 

corresponding movies related to all information on the 

smartphone. Normally Marathi movies are comparatively less 

promoted than Hindi through all world and there are hardly 

Marathi movie star cast, songs, videos are easily and fast 

available on the network. So through this project, the upcoming 

Marathi movie “Akrandan” will be highly promoted. The all 

information about this movie will be available on the 

smartphone. This project is only front end based which is an 

Eclipse as an IDE & all modules are developed in Java. The 

required device must have Android Operating System either on 

an emulator or smartphone. The database is not the offline one 

it is an only online database connection.  

About Client 

The Director: Mr. Shashikant Deshpande  

The Producer: Mr. Gautam Aher 

2. Literature survey 

To promote Marathi movies is a challenging job for their 

makers. The communication between the movie makers and the 

audience is only at the time of the promotion of the movies. 

Nowadays there is the availability of platforms like reality 

shows to promote movies. But there is the second option also 

available for the same that is to give more publicity through 

mobile applications to the movies. It is also surveyed that now 

a day’s most people use smartphones for their daily usages. So 

for our company, it’s a great chance to achieve our project 

objective. 

 As per the survey, a very less number of Marathi movies gets 

that much publicity comparatively Hindi or English movies. So 

our application gives the advantage to this movie is very much 

high context. A literature survey discusses published 

information in a particular subject area, and sometimes 

information in a particular subject area within a certain period. 

For the same purpose we surfed on the internet and in the end, 

we get to know that the movies having this type of application 

are promoted more resulted in success. 

So by taking into consideration all the reviews from the  

 

references which are matching with the requirements we are 

ready to accept this project to promote Marathi movie as like all 

other. For the development of the application, we refer to 

today’s human popular technology rather than doing it privately 

and sell the application so we decided to do it in Android-based 

which is highly preferred now a day and keep it as a free of cost 

on the internet. 

In the initial phases, we take a very popular software 

indicator in front of us. As like that software no user data 

required there only thing is to provide corresponding 

information to the user.  

3. Acquisition of knowledge 

This project belongs to various industries and domain 

experience. This project develops integrated hardware, 

software, and solutions that would enrich and enable various 

industries and businesses. The project's Front end is developed 

using Android and Backend used as Online Database 

Connection. 

A. Android 

Android is an operating system based on the Linux kernel 

with a user interface based on direct manipulation, designed 

primarily for touch screens mobile devices such as smartphones 

and tablet computers. The operating system uses touch inputs 

that loosely correspond to real-world actions, like swiping, 

tapping, pinching, and reverse pinching to manipulate on-

screen objects and a virtual keyboard. Despite being primarily 

designed for touch screen input, it also has been used in 

televisions, games consoles, digital cameras, and other 

electronics. As of 2011, Android has the largest installed base 

of any mobile OS and as of 2013, its devices also sell more than 

Windows, iOS and Mac OS devices combined.  

As of July 2013, the Google Play store has had over 1 million 

Android apps published, and over 50 billion apps downloaded. 

A developer survey conducted in April–May 2013 found that 

71% of mobile developers develop for Android. Android's 

source code is released by Google under open source licenses, 

although most Android devices ultimately ship with a 

combination of open source and proprietary software. Initially 

developed by Android, Inc., which Google backed financially 

and later bought in 2005, Android was unveiled in 2007 along 

with the founding of the Open Handset Alliance—a consortium 

of hardware, software, and telecommunication companies 
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devoted to advancing open standards for mobile devices.  

B. XML 

A layout defines the visual structure for a user interface, such 

as the UI for an activity or app widget. You can declare a layout 

in two ways: 

Declare UI elements in XML. Android provides a 

straightforward XML vocabulary that corresponds to the View 

classes and subclasses, such as those for widgets and layouts. 

Instantiate layout elements at runtime. Your application can 

create View and ViewGroup objects (and manipulate their 

properties) programmatically. The Android framework gives 

you the flexibility to use either or both of these methods for 

declaring and managing your application's UI. For example, 

you could declare your application's default layouts in XML, 

including the screen elements that will appear in them and their 

properties. 

You could then add code in your application that would 

modify the state of the screen objects, including those declared 

in XML, at run time. The ADT Plugin for Eclipse offers a layout 

preview of your XML — with the XML file opened, select the 

Layout tab. You should also try the Hierarchy Viewer tool, for 

debugging layouts — it reveals layout property values, draws 

wireframes with padding/margin indicators, and full rendered 

views while you debug on the emulator or device. 

The layout opts tool lets you quickly analyze your layouts 

and hierarchies for inefficiencies or other problems. The 

advantage of declaring your UI in XML is that it enables you to 

better separate the presentation of your application from the 

code that controls its behavior. Your UI descriptions are 

external to your application code, which means that you can 

modify or adapt it without having to modify your source code 

and recompile.  

For example, you can create XML layouts for different 

screen orientations, different device screen sizes, and different 

languages. Additionally, declaring the layout in XML makes it 

easier to visualize the structure of your UI, so it's easier to debug 

problems. As such, this document focuses on teaching you how 

to declare your layout in XML. If you're interested in 

instantiating View objects at runtime, refer to the ViewGroup 

and View class references. 

C. Eclipse 

Eclipse is an integrated development environment (IDE). It 

contains a base workspace and an extensible plug-in system for 

customizing the environment. Written mostly in Java, Eclipse 

can be used to develop applications. Eclipse may also be used 

to develop applications in other programming languages: Ada, 

C, C++, COBOL, Fortran, Haskell, JavaScript, Lasso, Perl, 

PHP, Python, R, Ruby (including Rubyonrails framework), 

Scala, Clojure, GroovyScheme, and Erlang. It can also be used 

to develop packages for the software Mathematica. 

Development environments include the Eclipse Java 

development tools (JDT) for Java and Scala, Eclipse CDT for 

C/C++ and Eclipse PDT for PHP, among others. The Eclipse 

SDK includes the Eclipse Java development tools(JDT), 

offering an IDE with a built-in incremental Java compiler and a 

full model of the Java source files. This allows for advanced 

refactoring techniques and code analysis. The IDE also makes 

use of a workspace, in this case, a set of metadata over a flat 

filespace allowing external file modifications as long as the 

corresponding workspace "resource" is refreshed afterward. 

Using Java Programming in Eclipse 

1. Start Eclipse. 

2. Select a workspace 

3. Each Java program we will write will be stored in its 

project. From the Eclipse menu bar at the top of the 

screen, choose File > New > Java Project… You will 

see the following New Java Project window: 

4. If you are starting a brand new Java project without 

any initial program code:  

5. Each program has one or more classes, one of which 

must contain the main method. To add a class to a 

project:  

6. If you are creating a project using Java files that are 

already stored in a folder for you (for example, the 

folder is named MySecondProgram):  

7. To remove a project from your workspace, select the 

name of a project in the Package Explorer (e.g. 

MySecondProgram), and then choose Edit > Delete. 

You have the option of removing just the project name 

or all of the code from your workspace. 

8. To exit out of Eclipse, choose File > Exit. 

4. System study 

A. Proposed system 

The proposed system is an application running on Android 

4.0 onwards smartphones. It will also run in computers by using 

the emulator of Android. It replaces traditional visual aid & 

enhances the business of both i.e. of our company’s well as of 

the filmmakers. The user who wants to use this application must 

visit the first Google PlayStore and have to search for the 

Application. The application will be available on the same. 

Then the user has to download that application and install it into 

the smartphone. After a successful installation, the proposed 

mobile application is ready to use. The user will get 

“Aakrandan” movie features like songs, videos, fun facts, photo 

gallery star cast information, etc. There is an Online database 

connection for the star cast information. No particular database 

is maintained here. Users can set a particular photo in a given 

gallery as a background as well as can share through the number 

of media. 

B. Benefits of the Proposed System 

New Age Enhanced Promotional Tool  

The flexibility of promotional media allows you to make audio 

visual. Android Smartphone enables a level of vision and 

control that far surpasses the traditional visual aid or any other 

approach. More important than media deployed are the 



International Journal of Research in Engineering, Science and Management  

Volume-2, Issue-12, December-2019 

www.ijresm.com | ISSN (Online): 2581-5792     

 

556 

intelligence and synchronization of the deployment. 

Use of Effective mean for publicity 

The primary advantage of Android smartphones is that it is 

highly popular with people. This highly portable computing 

device gives you full information about the movie i.e. its 

features. 

You can get overall all information under only one shade of 

this application. When compared to laptops or PCs the boot 

time for an Android Smartphone is almost null. It will help the 

film to get more popularity as well as more success.  

5. Problem definition & scope of project 

A. Problem Definition 

The problem definition is to create an application that can 

give all corresponding information about the upcoming Marathi 

movie AKRANDAN. This application should be produced 

individually means it should only for this movie and not in a 

generalized form. So no existing application should be 

developed or updated or altered. 

B. Objective 

The Objective of the project is to promote and be available 

corresponding movies related to all information on the 

smartphone. This project describes all the availability of 

features of “Aakrandan” upcoming Marathi movie through a 

web browser as well as through the smartphone of Android. 

Also, Extra features of Mobile Device Management is provided 

for giving a high level of data security and confidentiality to the 

data. 

6. Requirement analysis 

A. Analysis 

We have done an analysis part starting from requirements 

specification after gathering requirements from the client. As 

we know requirements are nothing but descriptions of the 

services that a software system must provide to the user and the 

constraints under which it must operate. Requirements can 

range from high-level abstract statements of services or system 

constraints to low-level parts of the system. As per this 

statement, we were collect all requirements from the client like 

what functionalities they want from an application. 

As the process of requirements engineering having work of 

establishing the services that the customer requires from the 

system and the constraints under which it is to be developed and 

operated; we are focused on the requirement specification & 

hourly follow all the engineering process. 

Requirements can be classified in the following category 

Following are the requirements identified during the process 

of requirement analysis stage of the project: 

 System Requirements: This application should be 

available only on devices Android operating system 

and not be accessible on any other device. The 

application should be able to manage from whom who 

knows about the smartphone functionalities. The 

application should be able to connect to the internet to 

Google play store for application downloading or wifi 

(if available) can be utilized. 

 Feasibility Study: As we know every project needs to 

have a feasibility study for the complete 

understandability of the project. We will consider the 

feasibility study it is technical feasibility and 

economic feasibility. The system feasibility can be 

divided into various checkpoints viz Technical 

feasibility & Economical feasibility. 

 Technical Feasibility: This deals with the hardware to 

be used in the proposed system, which should be 

economical reliable and easily maintainable. This 

raises a few questions about the availability of the 

pieces of equipment and its delivery timing. We have 

used Android O.S.& Eclipse for front end coding. And 

as the survey says more than 70% of internet users can 

use Android O.S. very efficiently. 

 Economic Feasibility: The economic feasibility study 

is the most frequently used technique for evaluating 

the effectiveness of the proposed system. The 

approach that we followed for the economic feasibility 

checking was COST-BENEFIT ANALYSIS the 

procedure is to determine the benefits and saving and 

compare them with the costs it benefits outweigh 

costs, a decision is taken to design and implement the 

system. So Android is free of cost operating system as 

well as the application stored on the play store so it is 

also free of cost for users who want to use it. So it is 

economically feasible for the user. Also, we 

completely consider about company’s economic 

feasibility. For the same we are including some 

advertisements to the beginning of each video contain 

in it. So that profit is coming into the company’s side. 

Minimum Hardware Requirements 

Processor: Intel i3. 

RAM: Recommended 2GB 

Hard Disk: Not Applicable 

Software Requirements 

Operating System – ANDROID 4.0 onwards. 

7.  Methodology 

A. Spiral Model 

The Spiral Life Cycle Model is a type of iterative software 

development model which is generally implemented in high-

risk projects. It was first proposed by Boehm. In this system 

development method, we combine the features of both, the 

waterfall model and prototype model. In the Spiral model, we 

can arrange all the activities in the form of a spiral. The decision 

of choosing this model is taken by the developer as well as 

project manager just because of the movie maker will give 

required information like songs, videos, fun facts step by step 
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as they will shoot it and provide us. So we developed small 

modules first and as per they provide us the information we 

have added to the corresponding module. The bigger point is 

the main motto of choosing the spiral model is checking for the 

risk factor because of the whole application is on internet 

storage as well as usage. So the number of attacks or problems 

may have to be faced. So periodically risk has to be analyzed. 

B. Phases of the Spiral Model 

 Plan: In this phase, the objectives, alternatives, and 

constraints of the project are determined and are 

documented. The objectives and other specifications 

are fixed to decide which strategies/approaches to 

follow during the project life cycle. 

 Risk Analysis: This phase is the most important part of 

the "Spiral Model". In this phase, all possible (and 

available) alternatives, which can help in developing a 

cost-effective project are analyzed and strategies are 

decided to use them. This phase has been added 

especially to identify and resolve all the possible risks 

in the project development. If risks indicate any kind 

of uncertainty in requirements, prototyping may be 

used to proceed with the available data and find out a 

possible solution to deal with the potential changes in 

the requirements. 

 Engineering: In this phase, the actual development of 

the project is carried out. The output of this phase is 

passed through all the phases iteratively to obtain 

improvements in the same. 

 Customer Evaluation: In this phase, a developed 

product is passed on to the customer to receive 

customer’s comments and suggestions which can help 

in identifying and resolving potential problems/errors 

in the software developed. This phase is very much 

similar to the TESTING phase. 

 

 

Table 1 

Table title comes here 

Tool Name Notation Description 

System 

 

System boundary where all use cases will reside. 

 

Actor 

 

Actor which uses the system. 

Use Case 

 

It is generally function or process in the system. 

Association 
 

It shows direct association between actor and use cases. 

Dependency 
 

It shows dependency between two use cases. 

Includes 

 

It means one use case includes another use case. 

Extends 

 

It means one use case invokes another use case 

optionally or sometimes. 

 

Uses 

 

It means one use case invokes another use case always. 

 

 

System

Actor

Registration

<<include>>

<<extend>>

<<uses>>
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8. Designing 

A. Overview 

The design document defines the overall flow and working 

concept of the system which will be implemented. There are 

different approaches to creating a design document, one among 

the widely used is UML (Uniform Modeling Language). To 

design this application, firstly identify all the required 

interfaces/screens. This results in the documented concept that 

describes the flow of Application. The concept is then 

converted into a design document with UML diagrams. UML 

is modeling language used to specify, visualize, modify, 

construct, and document the artifacts of an object-oriented 

system under development. 

UML combines technique from data modeling (entity 

relationship diagrams), business modeling (workflows), object 

modeling, and component modeling. It can be used with all 

processes, throughout the software development life cycle, and 

across different implementation technologies. UML diagrams 

represent two different views of a system model: Static (or 

structural) view: Emphasizes the static structure of the system 

using objects, attributes, operations and relationships. The 

structural view includes: 

Class diagrams 

Composite structure diagrams 

Sequence diagram 

B.  Use Case Diagram 

Use case diagram Description: 

A use case diagram depicts participation relationships 

between actors and use cases. The diagram has an association 

between an actor and each use case in which the actor 

participates. This diagram contains three basic components: 

Notations used in Use case diagram are as follows: 

It means one use case invokes another use case always. 

 

System Use-Case: 

 

9. Class diagram 

Description: A Class diagram is a visual representation of an 

application showing its classes and the relationships between 

those classes. When you open a Class diagram, the IDE displays 

a specific selection of UML element icons in the Modeling 

Palette. 

Using the Class diagram model, you describe the static 

structure of the elements in your application. The IDE lets you 

graphically create diagrams that contain classes. The classes are 

arranged in hierarchies that share common structure and 

behavior and are associated with other classes. Notations used 

in the Class Diagram are as follows: 

Class Diagram: 

 
Activity Diagram: An activity diagram depicts a workflow 

view of activities. You can also draw a system-level activity 

diagram in which each use case is modeled as an activity. That 
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activity diagram specifies the temporal sequencing of the use 

cases.  

 

 

A. Sequence Diagram 

A sequence diagram is an interaction diagram that details 

how operations are carried out: what messages are sent and 

when. Sequence diagrams are organized according to time. The 

time progresses as you go down the page. The objects involved 

in the operation are listed from left to right according to when 

they take part in the message sequence. 

 
 

 

 

Tool Name Notation Description 

Initial State 

 

The initial state of the activity. 

Action State 

 

Represents the activity. 

Decision 

 

One activity conditionally follows another activity. 

Synchronization 

 

Multiple activities either follow or precedes synchronization bar. 

Transition 
 

Shows the flow between activities. 

Signal send state 

 

Used to send the signals. 

 

Flow final 
 

Shows the final flow of activity. 

Final state 

 

Shows the final state i.e. end of activity. 

 

 

Issue Book

Invalid Member
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10. Implementation 

Splash Screen 

Splash screen appears as soon as application is started. 

 

 

Dashboard 

Dashboard is Main screen of the project. All the brands with 

their slides also filter options are displayed on Dashboard with 

proper alignment. Dashboard is nothing but Home screen of 

project.  

 
 

Drop-down Menu: After clicking open button on left side 

with icon “Akrandan”, the options such as Gallery, songs, 

Videos, Star cast, About us, fun facts become available. 

 

 
 

Gallery Screen: On clicking of any of the Gallery Button 

Screen shows all photos during movie shooting is get displayed 

on dashboard. Also we can set that photo as a wallpaper if we 

want as well as we can share it via any tool like facebook, 

whatsapp. 

  

 
 

Songs Screen: On clicking of any of the Song you can listen 

the provided movie songs. You can select anyone and can 

listen. 

 

 
 

 
 

Video Screen: On clicking on video button, you will get 

number of videos to see about movie through you tube. Also 

each video contains starting advertisement and then 

corresponding video. So for this your internet connection 

should be enabled one.  
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Star Cast Screen: On clicking on Star cast button, the list of 

the stars in the movie will display. Then after clicking on the 

particular star cast name in list you can get information about 

them through online only.  

 

 
 

Fun Facts Screen: On clicking of Funfacts Button, you can 

get in text format the funny moments during film making or 

shooting.  

 

 
 

A. Testing 

The process of testing was conducted using unit testing, 

integration testing, and operational testing. 

Unit Testing (Developer): Unit Testing is a level of the software 

testing process where individual units/components of a 

software/system are tested. The purpose is to validate that each 

unit of the software performs as designed. A unit is the smallest 

testable part of the software. It usually has one or a few inputs 

and usually a single output. In procedural programming, a unit 

may be an individual program, function, procedure, etc. In 

object-oriented programming, the smallest unit is a method, 

which may belong to a base/super class, abstract class or 

derived/child class. Unit testing frameworks, drivers, stubs and 

mock or fake objects are used to assist in unit testing. Unit 

testing is performed by using the White Box Testing method. 

When is it performed? 

We have done Unit testing as it is the first level of testing and 

is performed before Integration Testing. It contains all small 

units like modules of an application like Gallery, Video, Songs, 

Starcast, etc. We have also written test cases of the same which 

are placed in the following given table. 

Who performs it? 

For our project Unit Testing, there were 2 people from 

another project are appointed but it is normally performed by 

software developers themselves or their peers. In rare cases, it 

may also be performed by independent software testers. 

B. Benefits 

Unit testing increases confidence in changing/maintaining 

code. If good unit tests are written and if they are run every time 

any code is changed, the likelihood of any defects due to the 

change being promptly caught is very high. If unit testing is not 

in place, the most one can do is hope for the best and wait until 

the test results at higher levels of testing are out. Also, if codes 

are already made less interdependent to make unit testing 

possible, the unintended impact of changes to any code is less. 

Codes are more reusable. To make unit testing possible, 

codes need to be modular. This means that codes are easier to 

reuse. We have experienced that Development is faster. If you 

do not have unit testing in place, you write your code and 

perform that fuzzy ‘developer test’ (We set some breakpoints, 

fire up the GUI, provide a few inputs that hopefully hit your 

code and hope that you are all set.) 

We have written the test, code and run the tests. Writing tests 

takes time but the time is compensated by the time it takes to 

run the tests. The test runs take very less time: You need not fire 

up the GUI and provide all those inputs. And, of course, unit 

tests are more reliable than ‘developer tests’. Development is 

faster in the long run too. The reason for the same is the effort 

required to find and fix defects found during unit testing is 

peanuts in comparison to those found during system testing or 

acceptance testing. The cost of fixing a defect detected during 

unit testing is lesser in comparison to that of defects detected at 

higher levels. Compare the cost (time, effort, destruction, 
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humiliation) of a defect detected during acceptance testing or 

say when the software is live. Debugging is easy. When a test 

fails, only the latest changes need to be debugged. With testing 

at higher levels, changes made for several days/weeks/months 

need to be debugged. 

C. System testing (Test Manager) 

System Testing is a level of the software testing process 

where a complete, integrated system/software is tested. The 

purpose of this test is to evaluate the system’s compliance with 

the specified requirements. Here we had tested the entire 

application. The reference document for this process was the 

requirements document and the goal was to see that if the 

application meets the requirements.  

11. Test cases 

 

 

Component 

Name 

Dashboard/Main screen 

Purpose To check application is installed properly or not 

Sr. no. Test Case Test Input Expected Output Actual Output Remark 

1 To check application is installed 
properly or not 

Click on the 
application icon 

twice 

The dashboard of the 
movie should be 

displayed 

Dashboard is displayed 
clearly without fail 

Passed 

2. Check for the welcome button Click on Welcome 

button 

The dropdown menu 

should be displayed 

The dropdown menu 

displayed 
properly 

Passed 

Component 

Name 

Gallery Module 

Purpose Validation for Gallery screen and functionality 

Sr no. Test Case Test Input Expected Output Actual Output Remark 

3. Check Gallery screen is open after 

clicking on Gallery button. 

Click on Gallery 

button 

Gallery screen should 

open. 

Getting Gallery screen 

after clicking on Gallery 

button 

Passed 

4. Check after sliding the next photo 

is shown or not 

Slide the screen Next photo should be 

displayed. 

Next photo displayed 

without fail.. 

Passed 

5. Check after setting particular photo 

as a wallpaper it is set or not. 

 

Click on Set 

wallpaper button 

below photo 

Selected photo should 

be set as a wallpaper. 

Selected photo is set as a 

wallpaper properly 

Passed 

6. Check after sharing any photo to 

any tool whether it is shared or not 

Click on share 

button 
below photo 

Photo should be shared 

on selected tool. 

Photo displayed and 

shared through selected 
tool. 

Passed 

7. Check after sharing any photo to 

any tool whether it is shared or not 

Click on share 

button 
below photo. 

Photo should be shared 

on selected tool. 

Photo is not displayed and 

shared through selected 
tool.. 

Failed 

(Due to 
disconnecting 

internet) 

Component 

Name 

Song Module 

Purpose Validation for Song screen and its functionality 

Sr. no. Test Case Test Input Expected Output Actual Output Remark 

8. Check Song screen is open after 

clicking on Song 

Click on Song 

button 

Song screen should be 

displayed. 

Getting Song screen on 

clicking of Song button. 

Passed 

9 Check Song is playing after 
clicking on Play 

button 

Click on Play 
button 

Selected Song  should 
be played. 

Selected Song  played 
properly. 

Passed 

10. Check Song is stopping after 

clicking on Stop button or not 

Click on Stop 

button 

Selected Song which is 

playing should be 

stopped. 

Selected Song  which is 

playing Stooped properly. 

Passed 

Component 

Name 

Starcast Module 

Purpose Validation for Starcast screen and its functionality 

Sr no. Test Case Test Input Expected Output Actual Output Remark 

11. Check Starcast screen is open after 

clicking on Starcast 

Click on Starcast 

button 

Starcast screen should 

be displayed. 

Getting Starcast screen on 

clicking of Starcast 
button. 

Passed 

12. Check Starcast information is 

displaying after clicking on 

particular starcast in a list 
button 

Click on particular 

starcast in a list 

 

Selected Starcast 

information should be 

displayed. 

Selected Starcast 

information displayed 

properly. 

Passed 

13. Check Starcast information is 

displaying after clicking on 
particular starcast in a list 

Click on particular 

starcast in a list 
 

Selected Starcast 

information should be 
displayed. 

Selected Starcast 

information didn’t 
display. 

Failed 

(Due to 
disconnecting 

internet) 
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A. Maintenance 

Software maintenance in software engineering is the 

modification of a software product after delivery to correct 

faults, to improve performance or other attributes. A common 

perception of maintenance is that it merely involves fixing 

defects. However, one study indicated that the majority, over 

80%, of the maintenance effort is used for non-corrective 

actions. This perception is perpetuated by users submitting 

problem reports that in reality are functionality enhancements 

to the system. The key software maintenance issues are both 

managerial and technical. Key management issues are 

Alignment with customer priorities, staffing, which 

organization does maintenance, estimating costs. Key technical 

issues are Limited understanding, Impact analysis, Testing, 

Maintainability. 

12. Limitation and enhancement 

A. Limitations  

There is process limitation on the laptops as well as Tabs 

because of the development levels. The requirement of Android 

Version 4.0 and onwards, below versions does not support this 

application. For playing videos and for star cast information 

internet connection must be required. Users must know about 

Android Operating System working. 

B.  Enhancement 

Looking at the current limitations of the application, two out 

of major functional enhancement that you would find in the 

next release of this application are: If the company extends their 

contract then we will do the same application in window-based 

too. Still, some information about the movie release date, fun 

facts, and some more videos will be provided by the 

corresponding movie director. So after getting that one, the 

modules are again will be updated. Right now trying to 

generalize this application to work with the makers of another 

movie also.  

13. Conclusion 

 This paper presented an implementation of movie promotion 

application. 
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Component 

Name 

Video Module 

Purpose Validation for Video screen and its functionality 

Sr. no. Test Case Test Input Expected Output Actual Output Remark 

14. Check Video screen is open after 

clicking on Video 

Click on Video 

button 

Video screen should 

be displayed. 

Getting Video screen on 

clicking of Video button. 

Passed 

15. Check Video is playing after clicking 
on particular video option through 

“you tube” 

Click on 
particular video 

option 

Selected video 
should be played. 

Selected Video not played 
successfully through “you 

tube” 

Failed 
(Due to 

disconnecting 

internet) 

16. Check Video is playing after clicking 

on particular video option through 

“you tube” 

Click on 

particular video 

option 

Selected video 

should be played. 

Selected Video  played 

successfully through “you 

tube” 

Passed 

Component 

Name 

About us module 

Purpose Validate functionality for About us module 

Sr. no. Test Case Test Input Expected Output Actual Output Remark 

17. Check About us screen is open after 
clicking on About us 

Click on About 
us button 

About us screen 
should be displayed. 

Getting About us screen on 
clicking of About us button. 

Passed 

18. Closing of dropdown menu. Click on 

Akrandan icon. 

Dashboard should 

be displayed. 

Dashboard is getting 

displayed. 

Passed 

 

 


